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How	to	make	a	training	calendar	in	excel

The	overarching	mission	of	the	Bioinformatics	Training	and	Education	Program	(BTEP)	is	to	disseminate	information	and	best	practices	related	to	understanding	concepts	for	data	analysis	and	application	of	bioinformatics	tools	to	extract	meaningful	results	from	research	data.	BTEP	attempts	to	organize	comprehensive	bioinformatics	training	events
that	benefit	the	diverse	scientific	community	across	CCR,	and	achieves	this	through	a	multi-pronged	approach	of	scheduling	seminars,	webinars,	and	workshops	by	experts	(both	within	and	outside	of	NIH)	on	relevant	bioinformatics	topics.	One	of	the	primary	and	most	effective	ways	has	been	to	collaborate	with	analysts	using	open-source	software,	as
well	as	representatives	for	commercial	packages	(licensed	by	CCR/NCI/NIH),	to	organize	training	on	bioinformatics	tools	that	would	be	useful	for	the	CCR	scientific	community.	The	training	sessions	can	be	in	multiple	formats	depending	on	the	needs	of	the	software.	The	most	common	format	is	a	hands-on	workshop	that	is	generally	limited	to	25
students,	with	preference	being	given	to	CCR	personnel.	Other	formats,	as	mentioned,	include	informational	seminars,	introductory	webinars	and	more	comprehensive	talks,	based	on	various	criteria	related	to	the	software	tool	and	logistics.	By	Erika	Dean	i	BananaStock/BananaStock/Getty	Images	If	you	use	Microsoft	Excel,	you	have	access	to	many
Office	templates,	such	as	those	for	expense	reports,	invoices,	taxes,	and	calendars.	Using	these	templates	can	save	you	the	time	you	would	use	to	create	something	yourself.	If	you	need	to	add	a	three-month	calendar	to	Excel,	you	can	do	so	by	downloading	a	template	from	Microsoft	Office	Online.	Open	the	Excel	workbook	to	which	you	want	to	add	a
three-month	calendar.	Click	the	Office	button	and	select	"New."	This	will	open	a	list	of	Microsoft	Office	Online	templates.	Click	the	"Calendars"	tab	and	search	through	the	calendars.	When	you	find	a	three-month	calendar,	click	"Download."	The	calendar	template	will	open	in	a	new	page.	Highlight	the	calendar	with	your	mouse.	Right-click	and	select
"Copy."	Right-click	over	the	area	of	the	worksheet	you	want	to	insert	the	three-month	calendar,	then	select	"Paste."	A	three-month	calendar	will	now	be	added	to	your	Excel	worksheet.	We	are	proud	to	offer	a	variety	of	seminars	and	programs	that	are	pertinent	to	the	varied	work	we	do.	The	calendar	of	events	lists	these	seminars	and	programs.	If	you
have	any	questions	regarding	these	events,	please	contact	us.	One	of	the	first	things	people	do	when	they	make	the	decision	to	“get	organized”	is	buy	some	kind	of	calendar.	It	might	be	a	dayplanner,	a	desktop	“blotter-pad”	calendar,	a	Palm	or	Blackberry,	or	some	other	kind	of	device	or	system	they	can	schedule	all	their	appointments	and	obligations
in.Most	of	us	instinctively	understand	that	the	key	to	good	time	management	is	knowing	where	to	be	and	what	to	be	doing	there	at	any	given	time.	And	we	also	recognize	that	our	ability	to	keep	track	of	all	our	obligations	in	our	head	is	severely	limited.Effective	calendar	management	goes	hand	in	hand	with	good	task	list	management.	While	a	task	list
is	a	great	moment-to-moment	tool,	a	calendar	is	much	better	at	presenting	“the	big	picture”.	With	a	glance,	you	can	see	a	day,	a	week,	a	month,	even	a	year	at	a	time,	allowing	for	both	short-term	and	long-term	planning	in	a	way	that	a	task	list	can’t.What	kind	of	calendar?The	functional	requirements	of	a	calendar	are	pretty	basic:	Your	calendar
should	be	easy	to	write	in,	easy	to	read,	and	available	whenever	you	need	it.	How	those	criteria	are	going	to	be	best	met	is	really	up	to	you,	based	on	your	own	personality.	In	general,	calendars	fall	into	three	broad	categories:	paper	calendars	like	dayplanners	and	Moleskine	planners,	computer	programs	like	Outlook	and	Sunbird,	and	online	calendars
like	Google	Calendar	and	30	Boxes.	Each	type	of	calendar	has	its	own	pros	and	cons.Paper	CalendarsPros:	Great	for	people	who	think	best	with	a	pen	or	pencil	in	hand	Easy	to	use,	minimal	learning	curve	No	special	technology	needed	Never	runs	out	of	batteries	Cons:	Difficult	to	share	with	other	people	or	move	data	to	another	system	Limited
physical	space	makes	scheduling	far	in	advance	difficult	Recurring	events	need	to	be	entered	by	hand	Can	be	lost;	backup	strategies	are	awkward	at	best	(e.g.	photocopies)	Needs	to	be	replaced	every	year	Computer-based	CalendarsPros:	Appointments	and	recurring	events	are	easy	to	create	Data	can	be	exported	to	or	imported	from	other	systems
Events	can	be	emailed	to	other	people	Many	programs	allow	rules	to	be	set	up	determining,	for	example,	what	information	is	public	and	what	is	not	Notes,	files,	and	other	information	can	be	added	indefinitely	Can	schedule	events	easily	years	in	advance	Data	can	be	backed	up	regularly	Cons:	Data	corruption	is	possible,	altering	or	even	deleing
events	Too	many	options	can	make	simple	event	scheduling	complicated	Need	physical	access	to	your	computer	or	PDA/smartphone	to	see	schedule	On	PDAs:	batteries	can	fail,	leaving	you	calendar-less	Steeper	learning	curve	than	paper	Dependent	on	technology	Online	CalendarsPros:	Access	anywhere	you	have	an	Internet	connection,	including
public	computers	Share	your	calendar	or	part	of	your	calendar	easily	Some,	like	Google	Calendar,	have	natural	language	scheduling,	allowing	phrases	like	“lunch	with	Tom	tomorrow	at	noon”	to	be	translated	into	calendar	entries	Exchange	data	with	other	online	services,	like	task	lists,	web	sites,	RSS	readers,	weather	services,	news	sites,	etc.	Cons:
Security	concerns:	are	you	comfortable	allowing	Google	to	(potentially)	read	your	calendar	entries?	Security	vulnerabilities:	calendar	could	be	open	to	unauthorized	access	You	might	be	without	Internet	service,	or	the	site	could	go	down	At	the	mercy	of	host’s	business	plan	–	they	could	go	under,	taking	your	data	with	them	My	setup:	a	hybrid	calendar
systemI	use	a	combination	of	software-based	and	online	calendars.	My	primary	calendar	is	kept	in	Outlook	(totally	square,	I	know!).	I	also	have	an	online	calendar	with	Google.	Thanks	to	Google	Calendar	Sync,	a	program	that	runs	in	my	taskbar	and	synchronizes	my	Outlook	and	Google	calendars,	both	calendars	are	kept	up	to	date.	I	sync	my
Blackberry	with	Outlook,	which	means	I	always	have	a	copy	of	schedule	with	me.	If	I	add	events	on	the	Blackberry,	they	get	synced	to	Outlook	when	I	connect	to	my	PC,	and	those	changes	get	uploaded	to	Google	when	Google	Calendar	Sync	runs.	I	also	have	my	Outlook	.pst	file	(where	the	calendar	and	all	other	Outlook	data	is	stored)	set	to	save	to	an
external	drive	every	night.	So	I	have	multiple	redundancies	in	case	any	part	of	the	system	fails.	(I	also	print	a	hard	copy	from	Outlook	if	I’m	going	to	be	out	of	town,	just	in	case	my	Blackberry	breaks	and	I	can’t	find	a	computer	to	check	my	Google	calendar.)There	are	two	philosophies	about	how	to	use	your	calendar.	The	first,	which	is	recommended
by	David	Allen	in	Getting	Things	Done,	is	to	only	put	in	your	calendar	those	events	which	have	to	happen	at	that	time	–	meetings,	appointments,	scheduled	phone	calls,	etc.	The	rest	of	the	time,	you’re	working	from	your	task	lists	according	to	your	sense	of	what	the	most	important	thing	to	work	on	right	now	is.I	disagree	with	that	approach,	though	I
admit	it	seems	to	work	for	many	people.	But	I	believe	in	scheduling	everything	–	appointments	and	meetings,	but	also	blocks	of	time	for	email	or	phone	calls,	meals,	travel	time,	and	most	importantly,	“project	time”.	Project	time	is	a	block	of	time	devoted	to	making	progress	on	some	active	project	I’m	working	on	at	the	moment.	If	I	don’t	schedule	that
kind	of	stuff,	I	know	the	relatively	trivial	stuff	will	expand	to	fill	all	the	space	between	my	(rare)	scheduled	events	–	and	I	won’t	find	time	for	the	important	stuff.To	be	honest,	that	probably	isn’t	too	far	from	the	spirit	of	GTD,	even	if	it’s	against	the	“letter	or	the	law”	as	set	down	in	Allen’s	books.	Working	on	projects	often	is	something	that	has	to	be
done	at	a	set	time,	or	it	doesn’t	get	done.	Working	on	email	is	the	opposite	–	if	it’s	not	done	only	during	the	times	I	schedule,	it	can	easily	fill	the	whole	day.	My	advice,	then,	is	to	determine	what	absolutely	has	to	be	done	each	week	and	schedule	all	of	it	–	and	stick	to	the	schedule.	That	means	you	give	everything	you’ve	scheduled	the	full	block	of	time
allowed	to	it	–	but	not	more	than	that.	Use	a	timer,	if	necessary.	The	point	of	using	a	calendar	isn’t	just	to	make	sure	you	work	on	your	important	tasks	at	set	times	during	the	week,	it’s	also	to	make	sure	you	leave	adequate	time	for	the	stuff	that	can’t	be	easily	scheduled	–	time	“off	the	clock”,	enjoying	yourself.Your	calendarsWhat	about	you?	Are	you	a
fan	of	paper,	software,	or	“in	the	cloud”	calendars?	What’s	your	setup?	And	how	do	you	use	your	calendar	to	keep	yourself	on	track?	Tell	your	calendar	story	in	the	comments.Featured	photo	credit:	Pexels	via	pexels.com	So,	what	else	can	Excel	do?	People	ask	this	question	all	the	time.	The	answer	is	“almost	anything.”	Excel	has	evolved	into	one	of	the
most	versatile	programs	available.	In	addition	to	spreadsheets	that	calculate	everything,	it’s	also	a	database,	a	programming	tool,	a	graphics	program	with	charts,	tables,	drawing	tools,	photos,	clipart,	and	even	layout	abilities,	and	it’s	a	limited,	but	functioning,	word	processor	(with	a	spell	checker,	Thesaurus,	grammar	tools,	research	capabilities,
translation	functions,	and	more).	With	its	graphic	features,	you	can	create	anything	from	a	detailed	drawing	to	an	edited	photo.	You	can	make	calendars,	note	pads,	list	pads,	schedules,	grid/graph	paper,	greeting	cards,	business	cards,	etc.	If	you’re	wondering	why	anyone	would	use	Excel	over	programs	such	as	Photoshop	and/or	Illustrator,	the
answer	is	simple.	Not	everyone	has	access	to	graphics	and/or	photo-editing	software.	And,	although	Windows	includes	PC	Paint	as	an	Accessory	program,	it’s	actually	easier—in	many	cases—to	use	Excel	for	some	projects.	This	week,	a	calendar;	next	week,	note	pads	and	lists.	After	that,	we’ll	tackle	several	other	projects	for	those	who	prefer	to	use
Excel	for	graphics.	How	to	start	your	calendar	Open	a	blank	worksheet.	Highlight	Columns	A	through	G,	then	roll	your	cursor	down	to	extend	the	highlight	through	Row	7,	making	the	range	A1	through	G7.	From	the	Home	tab,	select	the	Cells	group,	and	click	Format	>	Column	Width.	Type	18	in	the	Column	Width	dialog	box,	then	click	OK.	With	the
range	still	highlighted,	select	the	Cells	group,	and	click	Format	>	Row	Height.	Type	75	in	the	Row	Height	dialog	box,	and	click	OK.	Move	your	cursor	to	the	Home	position,	A1.	Change	the	Row	Height	to	118.	Cursor	down	to	A2	and	change	the	Row	Height	to	30.	JD	Sartain	1-Select	range,	adjust	column	+	row	size.	Highlight	the	range	A1	through	G7
again.	Select	the	Page	Layout	tab,	choose	Orientation	from	the	Page	Setup	group,	and	click	Landscape.	Next,	click	Margins	from	the	same	tab	and	group,	and	select	Custom	Margins	from	the	list.	The	Margins	tab	in	the	Page	Setup	window	appears.	Press	the	Tab	key	once,	and	your	cursor	moves	to	the	first	setting:	Top.	TIP:	It’s	so	much	easier	and
faster	to	just	tab	and	type	through	these	settings,	rather	than	trying	to	highlight	each	field	box	and	cursor	the	up/down	arrows.	In	the	Top	field	box,	type	.25,	then	press	the	Tab	key	and	your	cursor	moves	to	Bottom.	Enter	.25,	press	the	Tab	key,	cursor	moves	to	the	Left	field	box.	Enter	.25,	Tab	to	the	Right	field	box,	enter	.25.	Press	the	Tab	key,
cursor	moves	up	to	Header,	enter	0.	Then	tab	again	down	to	Footer,	and	enter	0.	Press	Tab	again,	and	the	cursor	moves	to	the	Center	on	Page	panel.	Check	both	Horizontally	and	Vertically,	then	click	OK.	With	the	area	still	highlighted,	click	Print	Area	>	Set	Print	Area	from	the	same	tab	and	group.	It	looks	like	nothing	happened,	but	press	the	Home
key	once,	and	notice	the	solid	(or	dotted)	line	around	the	area	you	just	selected.	This	is	the	area	of	your	spreadsheet	that	Excel	prints,	as	long	as	you	don’t	change	the	Print	Area	to	something	else.	Highlight	a	new	area:	A2	through	G7.	Click	the	Borders	button	in	the	Fonts	group,	under	the	Home	tab,	then	choose	All	Borders	from	the	drop-down	list.
JD	Sartain	2-Page	Setup	and	Borders	for	your	calendar.	Enter	the	days	of	the	week	in	Row	2	(A2:G2),	center	horizontally	and	vertically,	then	enter	the	days	of	the	current	month	on	the	calendar.	Next,	merge	the	top	cells	into	one.	Highlight	Row	A1	through	G1,	then	select	Merge	&	Center	from	the	Merge	button	under	the	Home	tab,	Alignment	group.
Now,	let’s	add	a	fancy	title	(June	2015).	Click	Insert	>	Text	>	WordArt	and	choose	a	style	for	your	text	,	then	type	June	2015	in	the	field	box.		JD	Sartain	3-Merge	cells	and	insert	WordArt.	If	you’d	prefer	a	more	ornate	month	and	year,	try	some	clipart.	Delete	the	WordArt,	then	select	Insert	>	Illustrations	>	Online	Pictures,	and	type	June	in	the	search
box.	Choose	an	image	for	the	title,	then	size	to	fit.	Next,	add	some	clipart	images	to	decorate	your	calendar.	Select	Insert	>	Illustrations	>	Online	Pictures	again,	type	Summer	in	the	search	box,	then	choose	from	the	filtered	selection.	Size	to	fit	in	the	space	provided.	Note:	Sizing	down	is	usually	no	problem,	but	enlarging	(or	sizing	up)	will	likely	result
in	a	blurred	image.		JD	Sartain	4-Use	WordArt	or	clipart	to	enter	the	month	and	decorate	the	calendar.	If	you	happen	to	select	an	image	with	unwanted	areas,	such	as	a	picture	with	the	wrong	year,	you	can	crop	the	image	to	remove	that	element,	but	only	if	it’s	standing	alone	beside	a	border.	First,	the	image	must	be	selected	so	the	Picture
Tools/Format	menus	are	displayed.	Select	Format	>	Crop	>	Crop.	Notice	the	black	“handles”	around	the	image.	Put	your	mouse	cursor	on	one	of	the	handles,	hold	down	the	left	mouse	button,	and	then	slide	the	handle	up,	down,	or	over	to	crop	out	the	unwanted	sections.	When	satisfied,	click	anywhere	outside	the	image	borders	and	the	image	is
cropped.	JD	Sartain	5-Crop	unwanted	parts	out	of	the	images.	Next,	size	and	place.	But	the	background	is	blue,	and	you	want	a	transparent	background.	No	problem.	Select	the	image,	(the	Picture	Tools/Format	menus	appear).	Choose	Format	>	Remove	Background	>	Mark	Areas	to	Keep.	Use	the	handles	on	the	image	to	adjust	the	border	around	the
parts	of	the	picture	you	want	to	keep.	Since	you’ve	already	cropped	it,	just	stretch	the	borders	towards	the	center,	then	click	outside	the	image	area	and	it’s	done.	The	background	is	transparent,	the	wrong	year	is	cropped	out,	and	it’s	sized	to	fit	in	the	header	space	above	your	calendar.	JD	Sartain	6-Size,	place,	and	remove	the	image	background.
Last,	add	holidays	and	any	special	occasion	days	such	as	birthdays,	graduation,	or	anniversaries.	To	add	text	to	a	date,	position	your	cursor	on	the	target	date;	for	example,	June	12th.	Press	the	function	key	F2	to	edit	this	cell.	The	cursor	positions	to	the	right	of	the	number	12.	Because	the	numbers	are	on	the	bottom-right	corner—unless	you	want	to
change	that—press	the	Home	key	to	reposition	the	cursor	before	the	day.	Now	type	the	name	of	the	occasion,	then	press	Alt+Enter	(hold	down	the	Alt	key,	then	press	the	Enter	key,	then	release	both	keys),	once	for	each	additional	line	added—in	this	case,	once	to	separate	the	text	from	the	number,	then	three	more	times	to	move	the	text	to	the	top	of
the	calendar	box.	Now	the	data	is	on	the	right.	No	problem,	just	click	the	Align	Right	button	on	the	Home	tab,	Alignment	group	and	the	data	moves	to	the	right.	JD	Sartain		7-Add	special	occasion	days.	Note:	the	image	is	cropped	to	fit	this	page.	The	original	is	a	complete	seven-day	calendar.	Note:	You	cannot	right-justify	the	number,	then	center	or
left-justify	the	text,	because	Excel	doesn’t	allow	multiple	paragraph	styles	in	the	same	cell.	You	can	click	the	Increase	Indent	button	(also	in	the	Alignment	group)	to	move	the	data	two	pixels	away	from	the	right	border.	But	you	can	use	multiple	font	attributes	such	as	Bold	for	the	number	and	Italics	or	a	different	color	for	the	text.	Press	F2	to	edit,	then
highlight	the	number	or	the	text	and	choose	a	new	color	or	attribute.	If	you	want	both	the	same,	then	just	position	your	cursor	on	that	cell	and	choose	an	attribute	and	color.	Note:	When	you	purchase	something	after	clicking	links	in	our	articles,	we	may	earn	a	small	commission.	Read	our	affiliate	link	policy	for	more	details.
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